
Compaq Confidential – Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide  Comments: 

Part Number: AA-RBF2C-TE  File Name: a-frnt.doc  Last Saved On: 12/4/00 12:08 PM

Compaq StorageWorks™

Command Console V2.2 for the
RAID Array 3000 (Pedestal and
Rack Mount Models)
User’s Guide

Third Edition (January 2001)
Part Number AA-RBF2C-TE
Compaq Computer Corporation



Compaq Confidential – Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide  Comments: 

Part Number: AA-RBF2C-TE  File Name: a-frnt.doc  Last Saved On: 12/4/00 12:08 PM

© 2001 Compaq Computer Corporation.

COMPAQ, the Compaq logo and StorageWorks Registered with the U.S. Patent and
Trademark Office.

Microsoft, MS-DOS, Windows, and Windows NT are trademarks of Microsoft Corporation.

All other product names mentioned herein may be trademarks of their respective companies.

Confidential computer software. Valid license from Compaq required for possession, use or
copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software,
Computer Software Documentation, and Technical Data for Commercial Items are licensed to
the U.S. Government under vendor's standard commercial license.

Compaq shall not be liable for technical or editorial errors or omissions contained herein. The
information in this document is subject to change without notice.

THE INFORMATION IN THIS PUBLICATION IS PROVIDED “AS IS” WITHOUT
WARRANTY OF ANY KIND. THE ENTIRE RISK ARISING OUT OF THE USE OF THIS
INFORMATION REMAINS WITH RECIPIENT. IN NO EVENT SHALL COMPAQ BE
LIABLE FOR ANY DIRECT, CONSEQUENTIAL, INCIDENTAL, SPECIAL, PUNITIVE
OR OTHER DAMAGES WHATSOEVER (INCLUDING WITHOUT LIMITATION,
DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION OR LOSS
OF BUSINESS INFORMATION), EVEN IF COMPAQ HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES AND WHETHER IN AN ACTION OF CONTRACT
OR TORT, INCLUDING NEGLIGENCE.

The limited warranties for Compaq products are exclusively set forth in the
documentation accompanying such products. Nothing herein should be construed as
constituting a further or additional warranty.

Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide
Third Edition (January 2001)
Part Number AA-RBF2C-TE



Compaq Confidential – Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide  Comments: 

Part Number: AA-RBF2C-TE  File Name: a-frnt.doc  Last Saved On: 12/4/00 12:08 PM

Contents

About This Guide
Purpose and Scope................................................................................................. ix
Intended Audience................................................................................................. ix
Document Structure............................................................................................... ix
Related Documents................................................................................................ xi
Text Conventions ................................................................................................. xii
Symbols in Text ................................................................................................... xii
Symbols on Equipment ........................................................................................xiii
Rack Stability...................................................................................................... xiv
Getting Help........................................................................................................ xiv

Compaq Technical Support ........................................................................... xiv
Compaq Website ........................................................................................... xv
Compaq Authorized Reseller ......................................................................... xv

Chapter 1
Introduction

What is StorageWorks Command Console? ......................................................... 1-2
About the Client .................................................................................................. 1-3
About the Agent .................................................................................................. 1-3

Network Connection ..................................................................................... 1-3
Local Serial Port Connection......................................................................... 1-6
SCSI-Bus Connection Windows NT and  Windows 2000 .............................. 1-7
Available Connections .................................................................................. 1-9

Command Console’s Features............................................................................ 1-10
Hardware and Software Requirements......................................................... 1-11



iv  Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide

Compaq Confidential – Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide  Comments: 

Part Number: AA-RBF2C-TE  File Name: a-frnt.doc  Last Saved On: 12/4/00 12:08 PM

Chapter 2
Installing and Setting Up the Command Console Client

Installing Command Console Client..................................................................... 2-2
Stopping and Starting AES on Window NT and Windows 2000 ........................... 2-4
Removing the Command Console Client.............................................................. 2-5
Creating Your First Virtual Disk.......................................................................... 2-5

Establishing a Serial Connection, Single Controller ....................................... 2-6
Creating a Virtual Disk by Using a Serial Connection.................................... 2-9

Installing the Agent Software............................................................................. 2-19
Adding a System to the Navigation Tree ............................................................ 2-19
Fault Notification by Pager (TCP/IP Network Connections) ............................... 2-21

Chapter 3
Using Command Console

About the AES  (TCP/IP Network Connections Only).......................................... 3-2
Start Menu Options for Command Console .......................................................... 3-4
Choosing a Connection Method ........................................................................... 3-5

Establishing a Serial Connection, Single Controller ....................................... 3-6
Establishing a Serial Connection, Dual Controller ......................................... 3-7
Establishing a SCSI Connection, Single Controller........................................ 3-9
Establishing a SCSI Connection, Dual Controller ........................................ 3-10
Connecting Over a Network........................................................................ 3-12

Using the Navigation Window........................................................................... 3-15
Adding a System to the Navigation Tree ..................................................... 3-16
Deleting a System....................................................................................... 3-17
Creating and Using General Folders............................................................ 3-18
Renaming a Folder...................................................................................... 3-18
Viewing the Hierarchy in the Navigation Window....................................... 3-19
Viewing and Modifying a System Folder’s Properties ................................. 3-19
Opening a Storage Window ........................................................................ 3-20

Configuring a Single Controller ......................................................................... 3-20
Configuring a Dual-Controller System ............................................................... 3-25
Adding Devices................................................................................................. 3-27
Creating a Virtual Disk...................................................................................... 3-28
Deleting Virtual Disks ....................................................................................... 3-36
Modifying Virtual Disks.................................................................................... 3-37

Changing Virtual Disk Operating Parameters .............................................. 3-37
Removing Virtual Disk Members (Deleting Devices) .................................. 3-39

Setting Passwords and Security Options (Network Only).................................... 3-39
Managing and Creating Spare Devices............................................................... 3-40
Clearing Failed Devices..................................................................................... 3-41
Using Configuration Files.................................................................................. 3-41
Monitoring the Status of the RA3000................................................................. 3-43
Setting Up Pager Notification ............................................................................ 3-45

Setting Pager Preferences............................................................................ 3-46



Contents v

Defining a User Profile ............................................................................... 3-47
Setting Up Pager Codes for Numeric Pagers................................................ 3-49
Assigning a Pager Code to a Host System ................................................... 3-49
Assigning a Pager Code to a Subsystem Controller...................................... 3-50
Setting Up Notification Lists....................................................................... 3-51

Chapter 4
Command Console Client’s Windows, Menus, and Tools

Menus and Commands......................................................................................... 4-2
Drop-down Menus........................................................................................ 4-2
Shortcut Menus............................................................................................. 4-2

Navigation Window Menu Bar ............................................................................ 4-6
Navigation Window Toolbar................................................................................ 4-7
Navigation Window Status Bar ............................................................................ 4-8
Storage Window.................................................................................................. 4-9

Storage Window Menu Bar......................................................................... 4-10
Storage Window Toolbar ............................................................................ 4-11
Virtual Disk Window.................................................................................. 4-12
Device Window.......................................................................................... 4-15
EMU Icon................................................................................................... 4-22

Chapter 5
Maintenance and Troubleshooting

Backing up Files.................................................................................................. 5-1
Updating Controller Firmware ............................................................................. 5-2
General Troubleshooting Guidelines .................................................................... 5-3
Troubleshooting Client and Agent Connections.................................................... 5-4
Windows NT Event Logging ............................................................................... 5-5



vi  Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide

Compaq Confidential – Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide  Comments: 

Part Number: AA-RBF2C-TE  File Name: a-frnt.doc  Last Saved On: 12/4/00 12:08 PM

List of Figures
Figure 1-1.  Network connection.......................................................................... 1-5
Figure 1-2.  Local serial port connection .............................................................. 1-7
Figure 1-3.  Local SCSI bus connection ............................................................... 1-8
Figure 2-1.  First SWCC Setup screen.................................................................. 2-4
Figure 2-2.  Second SWCC Setup screen for Client Installation............................ 2-5
Figure 2-3.  Connection dialog box for storage window........................................ 2-8
Figure 2-4.  Establishing a connection to the top controller................................... 2-9
Figure 2-5.  Establishing a connection to the second (redundant) controller ........ 2-10
Figure 2-6.  Virtual disk wizard step 1 ............................................................... 2-12
Figure 2-7.  Virtual disk wizard step 2 (rack mount model) ................................ 2-13
Figure 2-8.  Virtual disk wizard step 3 ............................................................... 2-14
Figure 2-9.  Virtual disk partitions ..................................................................... 2-15
Figure 2-10.  Virtual disk wizard step 4.............................................................. 2-15
Figure 2-11.  Virtual disk wizard step 5.............................................................. 2-16
Figure 2-12.  Virtual disk wizard step 6.............................................................. 2-17
Figure 2-13.  Successful completion dialog box ................................................. 2-17
Figure 2-14.  Storage window during creation of virtual disks U01 and U02 ....... 2-18
Figure 2-15.  Storage window after creation of virtual disks U01 and U02 .......... 2-18
Figure 2-16.  Adding an agent system to the Navigation Tree ............................. 2-20
Figure 2-17.  System added to the Navigation Tree ............................................ 2-21
Figure 3-1.  Path for Command Console .............................................................. 3-4
Figure 3-2.  Connection choices for connecting to a single storage

subsystem ....................................................................................... 3-4
Figure 3-3.  StorageWorks Command Console Navigation window...................... 3-5
Figure 3-4.  HSZ22 Management Serial Connection dialog box for  Storage

window........................................................................................... 3-6
Figure 3-5.  Establishing a serial connection to the top controller.......................... 3-7
Figure 3-6.  Establishing a serial connection to the ............................................... 3-8
Figure 3-7.  HSZ22 Management: Local SCSI connection dialog box................... 3-9
Figure 3-8.  HSZ22 Management: Local SCSI connection dialog box, dual

controller ...................................................................................... 3-11
Figure 3-9.  HSZ22 Local SCSI connection dialog box for redundant

controller ...................................................................................... 3-11
Figure 3-10.  HSZ22 Management: TCP/IP Network Connection dialog box ...... 3-13
Figure 3-11.  Navigation window without the Navigation Tree ........................... 3-14
Figure 3-12.  Navigation window with the Navigation Tree................................ 3-15
Figure 3-13.  Adding an agent system to the Navigation Tree ............................. 3-16
Figure 3-14.  System added to the Navigation Tree ............................................ 3-17
Figure 3-15.  Adding a general folder................................................................. 3-18
Figure 3-16.  System properties for an agent system........................................... 3-19
Figure 3-17.  General controller properties tab ................................................... 3-21
Figure 3-18.  Host ports controller properties tab................................................ 3-22
Figure 3-19.  Environment controller properties tab............................................ 3-23
Figure 3-20.  Cache controller properties tab...................................................... 3-24
Figure 3-21.  Host ports default settings for dual-controller Windows................. 3-26



Contents vii

Figure 3-22.  Add new device dialog box ........................................................... 3-27
Figure 3-23.  Add Virtual Disk: Step 1 of 6........................................................ 3-28
Figure 3-24.  Add Virtual Disk: Step 2 of 6 (rack mount model) ......................... 3-29
Figure 3-25.  Add Virtual Disk: Step 3 of 6........................................................ 3-30
Figure 3-26.  Virtual disk partitions.................................................................... 3-31
Figure 3-27.  Add Virtual Disk: Step 4 of 6........................................................ 3-31
Figure 3-28.  Add Virtual Disk: Step 5 of 6........................................................ 3-32
Figure 3-29.  Add Virtual Disk: Step 6 of 6........................................................ 3-33
Figure 3-30.  Add Virtual Disk: Successful completion dialog box ..................... 3-33
Figure 3-31.  Storage window during creation of virtual disks ............................ 3-34
Figure 3-32.  Storage window after creation of virtual disks ............................... 3-34
Figure 3-33.  Virtual disk properties General tab ................................................ 3-36
Figure 3-34.  Virtual disk properties Settings tab................................................ 3-37
Figure 3-35.  Security options menu................................................................... 3-38
Figure 3-36.  Configuration file submenu........................................................... 3-40
Figure 3-37.  Save Configuration dialog box ...................................................... 3-40
Figure 3-38.  Restore Configuration dialog box.................................................. 3-41
Figure 3-39.  Environment tab ........................................................................... 3-43
Figure 3-40.  Event Notification Preferences dialog box ..................................... 3-45
Figure 3-41.  Pager tab configured for a numeric pager ...................................... 3-46
Figure 3-42.  Numeric pager readout.................................................................. 3-48
Figure 3-43.  Setting up a notification list........................................................... 3-50
Figure 3-44.  Selecting a group for notification .................................................. 3-51
Figure 4-1.  Console Client navigation and storage windows ................................ 4-2
Figure 4-2.  RAID Array 3000 navigation window............................................... 4-3
Figure 4-3.  Navigation window menu bar ........................................................... 4-6
Figure 4-4.  Toolbar............................................................................................. 4-7
Figure 4-5.  Status bar.......................................................................................... 4-8
Figure 4-6.  Multiple storage windows opened from the navigation window ......... 4-9
Figure 4-7.  Storage window menu bar............................................................... 4-10
Figure 4-8.  Storage window toolbar .................................................................. 4-11
Figure 4-9.  Virtual disk window ....................................................................... 4-12
Figure 4-10.  Virtual disk window view options ................................................. 4-12
Figure 4-11.  Virtual disk details view................................................................ 4-14
Figure 4-12.  Device window (grid view shown) ................................................ 4-15
Figure 4-13.  Device general property sheet ....................................................... 4-16
Figure 4-14.  Device membership property sheet................................................ 4-17
Figure 4-15.  Support information property sheet ............................................... 4-18
Figure 4-16.  Cabinet view of the pedestal model ............................................... 4-20
Figure 4-17.  View of rack four shelf with two channels small............................ 4-21
Figure 4-18.  EMU icon..................................................................................... 4-22
Figure 5-1.  Update firmware command ............................................................... 5-2
Figure 5-2.  Firmware Update dialog box ............................................................. 5-3



viii  Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide

Compaq Confidential – Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide  Comments: 

Part Number: AA-RBF2C-TE  File Name: a-frnt.doc  Last Saved On: 12/4/00 12:08 PM

List of Tables
Table 1 Related Documents ................................................................................... xi
Table 1-1 Connections That Can Be Used with SWCC......................................... 1-2
Table 1-2 How to Set Up SWCC for a Network Connection................................. 1-4
Table 1-3 How to Set Up SWCC for a Serial Connection ..................................... 1-6
Table 1-4 How to Set Up SWCC for a Local SCSI Bus Connection...................... 1-8
Table 1-5 Features of Connections Supported by the RA3000 .............................. 1-9
Table 1-6 Minimum Hardware and Software Requirements................................ 1-11
Table 3-1 Pager Critical Event Codes................................................................. 3-50



Compaq Confidential – Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide  Comments: 

Part Number: AA-RBF2C-TE  File Name: a-frnt.doc  Last Saved On: 12/4/00 12:08 PM

About This Guide

Purpose and Scope
This guide is designed to be used as step-by-step instructions to run and use
the Compaq StorageWorks TM Command Console V2.2 for the RAID Array
3000 (Pedestal and Rack Mount Models) User’s Guide.

Intended Audience
This document is written for installers and operators.

Document Structure
This guide contains the following information:

Chapter 1: Introduction

■ What is the StorageWorks Command Console

■ About the Client

■ About the Agent

■ Command Console’s Features
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Chapter 2: Installing and Setting Up the Command Console Client

■ Installing Command Console Client

■ Stoping and Straring AES on Windows NT and Windows 2000

■ Removing the Command Console Client

■ Creating your First Virtual Disk

■ Installing the Agent software

■ Adding a System to the Navigation Tree

■ Fault Notification by Pager (TCP/IP Network Connections)

Chapter 3: Using Command Console

■ About the AES (TCP/IP Network Connections only)

■ Start Menu Options for Command Console

■ Choosing a Connection Method

■ Using the Navigation Window

■ Configuring a Single Controller

■ Configuring a Dual Controller System

■ Adding devices

■ Creating a Virtual disk

■ Deleting Virtual disks

■ Modifying Virtual disks

■ Setting Passwords and Security Options (Network Only)

■ Managing and Creating Spare Devices

■ Clearing Failed Devices

■ Using Configuration Files

■ Monitoring the Status of the RA3000

■ Setting Up Pager Notification
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Chapter 4: Command Console Client’s Windows, Menus and Tools

■ Menus and Commands

■ Navigation Window Menu Bar

■  Navigation Window Toolbar

■ Navigation Window Status Bar

■ Storage Window

Chapter 5: Maintenance and Troubleshooting

■ Backing up files

■ Updating Controller Firmware

■ General Troubleshooting Guidelines

■ Troubleshooting Client and Agent Connections

■ Windows NT Event Logging

Related Documents
In addition to this guide, the following documentation is useful to the reader:

Table 1
Related Documents

Document Title Part Number

RAID Array 3000 Subsystem Second
Controller Option Installation Guide

EK-SM3KC-IG.E01

RAID Array 3000 Controller Shelf Hardware
User’s Guide

EK-SMCPQ-UG.D01

RAID Array 3000 Pedestal Storage Subsystem
Hardware User’s Guide

EK-SMCPO-UG.C01
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Text Conventions
This document uses the following conventions to distinguish elements of text:

Keys Keys appear in boldface. A plus sign (+) between
two keys indicates that they should be pressed
simultaneously.

USER INPUT User input appears in a different typeface and in
uppercase.

FILENAMES File names appear in uppercase italics.

Menu Options,
Command Names,
Dialog Box Names

These elements appear in initial capital letters.

COMMANDS,
DIRECTORY NAMES,
and DRIVE NAMES

These elements appear in uppercase, unless case
sensitive.

Type When you are instructed to type information, type
the information without pressing the Enter key.

Enter When you are instructed to enter information, type
the information and then press the Enter key.

Symbols in Text
The following symbols are found in the text of this guide to indicate different
types of information.

WARNING:  Text set off in this manner indicates that failure to follow directions
in the warning could result in bodily harm or loss of life.

CAUTION:  Text set off in this manner indicates that failure to follow directions
could result in damage to equipment or loss of information.

IMPORTANT:  Text set off in this manner presents clarifying information or specific
instructions.
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NOTE:  Text set off in this manner presents commentary, sidelights, or interesting points
of information.

Symbols on Equipment
The following symbols are placed on equipment to indicate the presence of
potentially hazardous conditions:

This symbol in conjunction with any of the following symbols indicates the
presence of a potential hazard. The potential for injury exists if warnings
are not observed. Consult your documentation for specific details.

This symbol indicates the presence of hazardous energy circuits or electric
shock hazards. Refer all servicing to qualified personnel.

WARNING:  To reduce the risk of injury from electric shock hazards, do not
open this enclosure. Refer all maintenance, upgrades, and servicing to
qualified personnel.

This symbol indicates the presence of electric shock hazards. The area
contains no user or field serviceable parts. Do not open for any reason.

WARNING:  To reduce the risk of injury from electric shock hazards, do
not open this enclosure.

This symbol on an RJ-45 receptacle indicates a Network Interface
Connection.

WARNING:  To reduce the risk of electric shock, fire, or damage to the
equipment, do not plug telephone or telecommunications connectors into
this receptacle.

This symbol indicates the presence of a hot surface or hot component. If
this surface is contacted, the potential for injury exists.

WARNING:  To reduce the risk of injury from a hot component, allow the
surface to cool before touching.
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These symbols on power supplies or systems indicate the

equipment is supplied by multiple sources of power.

WARNING: To reduce the risk of injury from electric shock,

remove all power cords to completely disconnect power from

the system.

Weight in kg

Weight in lb

This symbol indicates that the component exceeds the recommended

weight for one individual to handle safely.

WARNING: To reduce the risk of personal injury or damage to the

equipment, observe local occupational health and safety requirements and

guidelines for manual material handling.

Rack Stability

WARNING: To reduce the risk of personal injury or damage to the equipment,

be sure that:

■ The leveling jacks are extended to the floor.

■ The full weight of the rack rests on the leveling jacks.

■ The stabilizing feet are attached to the rack if it is a single rack

installation.

■ The racks are coupled together in multiple rack installations.

■ Only one component is extended at a time. A rack may become unstable

if more than one component is extended for any reason.

Getting Help

If you have a problem and have exhausted the information in this guide, you
can get further information and other help in the following locations.

Compaq Technical Support

In North America, call the Compaq Technical Phone Support Center at
1-800-OK-COMPAQ.  This service is available 24 hours a day, 7 days a week.
For continuous quality improvement, calls may be recorded or monitored.
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Outside North America, call the nearest Compaq Technical Support Phone
Center. Telephone numbers for worldwide Technical Support Centers are
listed on the Compaq website. Access the Compaq website:

http://www.compaq.com

Be sure to have the following information available before you call Compaq:

■ Technical support registration number (if applicable)

■ Product serial number

■ Product model name and number

■ Applicable error messages

■ Add-on boards or hardware

■ Third-party hardware or software

■ Operating system type and revision level

Compaq Website

The Compaq website has information on this product. Access the Compaq
website:

http://www.compaq.com/storage

Compaq Authorized Reseller

For the name of your nearest Compaq authorized reseller:

■ In the United States, call 1-800-345-1518.

■ In Canada, call 1-800-263-5868.

■ Elsewhere, see the Compaq website for locations and telephone
numbers
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Chapter 1
Introduction

This chapter defines StorageWorks Command Console, describes Command
Console’s features, and provides network and device support information.

What is StorageWorks Command
Console?

SWCC is a program, which provides a method of monitoring, configuring, and
troubleshooting your RA3000. Command Console is comprised of three
components: The Command Console Client, the HSZ22 Client, and the HSZ22
Agent.

You can use Command Console with three different connections
(Table 1-1): Serial, Small Computer System Interface (SCSI), and TCP/IP
network. You need to install the Client software with all of these connections.
If you plan to use Command Console over a TCP/IP network, you need to also
install the agent software.

Table 1-1
Connections That Can Be Used with SWCC

Connections That Can Be Used with SWCC Agent Software Required?

Network connection by means of TCP/IP Yes

Direct serial connection No

Host-bus SCSI connection No
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About the Client
The Client is the Graphical User Interface (GUI) program designed for
Windows NT 4.0 SP4, and Windows 2000. It provides a method of
configuring, operating, monitoring, and troubleshooting your storage
subsystem. The client is divided into two parts: The Command Console Client
and the HSZ22 Client. The Command Console Client provides the navigation
window that you see when you select StorageWorks Command Console in
Start|Programs|Command Console.

This Navigation window provides you with the navigation tree in addition to
other functions. The navigation tree provides a way for you to manage your
systems. The HSZ22 Client provides a Storage window that displays the status
of a particular subsystem. You can access the Storage window by selecting
HSZ22 Storage window in Start|Programs|Command Console or by using the
navigation tree (TCP/IP network connections only). The Storage window
displays the status of the virtual disks connected to the HSZ22 controller.

NOTE:  The HSZ22 refers to the controller, which is installed in the RA3000 pedestal or
rack mount system.

About the Agent
The Agent is a companion program that is installed on one of the supported
operating systems that a controller is connected to. The Agent program runs in
the background as a service, letting the Client communicate with your storage
subsystem over a network. A subsystem is comprised of the controller and the
hard drives that are connected to it.

Network Connection

SWCC has sophisticated networking capabilities. If Client is running on a
local system that has a TCP/IP network connection, you can connect SWCC
through the network to a host system that has the Agent program and is
connected to your storage subsystem.

Agent acts as Client’s assistant in controlling your storage subsystem.
Commands sent from Client are received by agent and are routed to the
storage subsystem through the subsystem’s SCSI host bus. Subsystem status is
transmitted back to Client from agent through the network connection. You
can also use Agent for access protection.
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By using a network connection, you can configure and monitor your storage
subsystem from anywhere on your local area network (LAN), which is a
network confined to a single geographic location. If your have a wide area
network (WAN) or a connection to the Internet, you can also monitor your
subsystem with the TCP/IP network protocol.

NOTE:  SWCC does not support the dynamic host configuration protocol (DHCP) or the
Windows Internet Name Service (WINS).

Table 1-2 lists a brief overview of the steps that you need to complete:

Table 1-2
How to Set Up SWCC for a Network Connection

Step Procedure

1 Install the Client software. See Chapter 2 “ Installing and Setting Up the
Command Console Client”

2 Create a virtual disk by using a serial connection. See Chapter 2 “ Installing
and Setting Up the Command Console Client”

3 Set up a TCP/IP connection for the Clients and Agent. Connect the RA3000 by
using a SCSI cable to the host adapter. See Figure 1-1.

4 Install the HSZ22 Agent. Refer to the Getting Started RAID Array 3000
Installation Guide for your operating system and platform.

5 Add the name of the Client system to the Agent’s list of Client system entries.
Refer to the Getting Started RAID Array 3000 Installation Guide for your
operating system and platform.

6 Add the name of the Agent system to the navigation tree of each Client
system that is on the Agent’s list of Client system entries. See, “ Adding a
System to the Navigation Tree,”  in Chapter 2 “ Installing and Setting Up the
Command Console Client” .

7 Set up pager notification. See Chapter 3 “ Using Command Console” .
E-mail notification is also available for some operating systems.
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Figure 1-1 shows a Network connection.

Host

SCSI host bus

Storage
subsystem

LKG-10478-WI

TCP/IP
Network

Agent
PCClient

PCClient

PCClient

Server

Figure 1-1.  Network connection
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Local Serial Port Connection

The simplest connection to the storage subsystem is a direct cable connection
from the local system that has the storage window installed to one of the
subsystem controller’s serial maintenance ports (Figure 1-2). Because direct
serial connections are only available with a stand-alone Storage window, you
will be not be able to connect locally to a subsystem by means of the
Navigation Tree. Table 1-3 lists an overview of the steps that you need to
complete:

Table 1-3
How to Set Up SWCC for a Serial Connection

Step Procedure

1 Install the Client software. See Chapter 2 “ Installing and Setting Up the
Command Console Client” .

2 Set up a serial connection. See Figure 1-2.

3 Create a virtual disk by using a serial connection. See Chapter 2 “ Installing and
Setting Up the Command Console Client” .

4 For more information, see “ Establishing a Serial Connection Single Controller”
and Establishing a Serial Connection, Dual Controller”  in Chapter 2.
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Figure 1-2 shows a local serial port connection.

Host

SCSI host bus

PCClient

Storage
subsystem

Serial
maintenance
port connection

LKG-10476-W

Server

Figure 1-2.  Local serial port connection

SCSI-Bus Connection Windows NT and
Windows 2000

You can use the SCSI connection to connect the Client to your storage
subsystems. To do this, you must connect the Compaq StorageWorks
controller subsystem to the Client system through the SCSI-bus (Figure 1-3).
In addition, the subsystem must contain at least one configured virtual disk.

If your subsystem does not contain a configured virtual disk, you must
establish a temporary connection through the controller’s serial maintenance
port, to create a virtual disk for the subsystem. Table 1-4 lists an overview of
the steps that you need to complete:
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Table 1-4
How to Set Up SWCC for a Local SCSI Bus Connection

Step Procedure

1 Install the Client software. See Chapter 2 “ Installing and Setting Up the
Command Console Client”

2 Create a virtual disk by using a serial connection. See Chapter 2 “ Installing and
Setting Up the Command Console Client” .

3 Set up a SCSI connection for the hardware. See Figure 1-3.

4 Use SWCC to establish a SCSI bus connection (Start|Programs|Command
Console|HSZ22 Storage Window). For more information, see “ Establishing a
SCSI Connection, Single Controller”  and Establishing a SCSI Connection, Dual
Controller”  in Chapter 3.

Host

SCSI host bus

Storage
subsystem

Client

LKG-10477-W

Server

Figure 1-3.  Local SCSI bus connection
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Available Connections

Features and limitations of the available connections must be considered in
choosing a connection to use for Client and your subsystems. Each connection
differs in the type of features and limits. Table 1-5 lists features that are
offered by each connection.

Table 1-5
Features of Connections Supported by the RA3000

Connection
Type

Create
Virtual Disk

Delete
Virtual Disk

Fault Events:
Client Visual
Notification

Fault
Events:
Paging
Notification

Fault Events:
Event
Logging

Local serial
connection

(navigation tree
and agent not
used)

Supported Supported Supported Not
supported

Not supported

Local SCSI bus
connection

(navigation tree
and agent not
used)

Supported Supported Supported Not
supported

Not supported

Remote network
connection

(client and agent
on different
computers

remote network
connection)

Supported Supported Supported Supported Supported

NOTE:  You can reconfigure the storage subsystems by using SWCC. For the operating
system to properly reflect these changes, you may need to take action outside the scope
of SWCC, such as initializing the drive or restarting the system. For further information,
refer to the operating system documentation.
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Command Console’s Features
The following are Command Console’s features:

■ Manages StorageWorks RAID Arrays over a serial port, SCSI bus, or
TCP/IP network.

■ Configures RAID Arrays using menus, icons, and system views.

■ Features an explorer-like Navigation window, which allows you to
obtain the properties of your storage systems and subsystems. This
feature is only available to TCP/IP network connections.

■ Upgrades the firmware for the controller by using the Storage window
(Storage|Controller|Update firmware).

■ Monitors storage subsystems including power, fan, temperature, device,
controller, and cache.

■ Provides password protection to prevent unauthorized access to the
subsystems.

■ Interfaces with Windows NT logging capability. Lists RAID array
events in the Application Log of the Windows Event Log Viewer
(Start|Programs|AdministrativeTools|Event viewer).

■ Includes indexed, context-sensitive, and “ What’s This?”  online Help.

■ Notifies you of subsystem problems by pager. This feature is only
available to TCP/IP network connections.
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Hardware and Software Requirements
The minimum requirements to properly run Command Console are listed in
Table 1-6.

Table 1-6
Minimum Hardware and Software Requirements

Item Requirements

Management station Intel 486/66 MHz with 16 MB of RAM memory and 10-MB
free hard disk space.

Operating system Windows NT 4.0 SP4 and Windows 2000.

Monitor VGA at 800x600 resolution.

Modem Hayes-compatible (for event notification).

Serial port RS-232 (for local connection).

Network adapter See Chapter 2 “ Installing and Setting Up the Command
Console Client”

Controller compatibility The RAID Array 3000 controller (HSZ22).

Host software ASPI SCSI driver required for host port virtual terminal
connection.
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Chapter 2
Installing and Setting Up the Command

Console Client

This chapter covers how to install the Command Console Client and set up the
software so that it can communicate with your RA3000.

Before you can use StorageWorks Command Console (SWCC), you will need
to complete the following steps:

 1. Install the Command Console Client. The HSZ22 Client will also install.
The HSZ22 Storage window displays the status of the virtual disks
connected to a particular controller.

 2. Create a virtual disk by using a serial connection.

 3. If you are planning to use SWCC over a TCP/IP network, you also need
to install the Agent software on the computer that is connected to your
HSZ22 controller. Refer to the Getting Started RAID Array Installation
Guide for your operating system and platform.
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This chapter will tell you how to complete these steps. For information on how
to upgrade the controller firmware, refer to the Getting Started RAID Array
3000 Installation Guide for your operating system and platform.

This chapter also contains information on how to add an Agent system to the
Navigation Tree. This chapter also provides information on setting up the
Command Console so it sends fault notification by pager. The Navigation Tree
shows the status of your storage systems in the Navigation window. The
Navigation window is the window that appears when you click
Start|Programs|Command Console|StorageWorks Command Console.

Installing Command Console Client
You can install the Command Console Client from a CD-ROM onto
Windows NT 4.0 SP4, and Windows 2000. The installation program is self-
extracting and it installs the Command Console Client into the directory
C:\program files\SWCC by default. During setup, you have the option to
install the program on a different hard drive.

Before you install the Client software, you should read the release notes that
came with this kit. If you have the Command Console Client version 1.1b or
earlier, remove the program and the Asynchronous Event Service (AES).

Install the client software as follows:

 1. Place the CD titled RA3000 Solution Software Version 1.3 in the CD-
ROM drive.

 2. Run File Manager or Windows Explorer.

 3. Navigate to the folder drive_letter:\SWCC

 4. Double-click Setup.

 5. Follow the instructions in the setup program to complete the installation.
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 6. The first screen of the SWCC setup displays (Figure 2-1). Select the
options to install the SWCC Navigation window and the HSZ22
Controller. The last option installs the HSZ22 device-specific Client for
SWCC. Click Next

Figure 2-1.  First SWCC Setup screen
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 7. The second SWCC Setup screen is displayed (Figure 2-2). The default
installation directory can be changed with the Browse button. Click
Next.

Figure 2-2.  Second SWCC Setup screen for Client Installation

 8. The Asynchronous Event Service (AES) starts and the following
software installs:

 a. Command Console Client

 b. HSZ22 Client

NOTE:  After the Command Console Client is installed, you can access its Help, which
provides detailed information on the configuration and use of Command Console. You can
access Help for the Command Console by clicking Help in its window.

The installation will install the Command Console Client and the HSZ22
Client, which contains the HSZ22 Storage window. After the program installs,
it will start the AES.
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Stopping and Starting AES on Window NT
and Windows 2000

To stop or start AES:

 1. Open the Services window (Start|Settings|Control Panel|Services).

 2. Click the AsyncEventSvc entry.

 3. Click Stop or Start, then click Close.

To disable the automatic start of AES when your system boots, change the
startup option to manual in the Services window, as described below:

 1. Open the Services window, (Start|Settings|Control Panel|Services).

 2. Double-click the AsyncEventSvc entry. The Service window appears.

 3. Select Manual under Startup Type, and click OK.
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Removing the Command Console Client
Before you remove the Command Console Client from your computer, remove
AES from Windows. This will prevent the system from reporting that a service
failed to start every time the system is booted. Steps 2 through 4 tell you how
to remove the Command Console Client.

 1. Remove AES from the computer.

 2. Go to the command prompt (Start|Programs|Command Prompt) and
change to the directory to which you installed the Command Console
Client. Type the following command and then press the Enter key:

C:\Program Files\COMPAQ\SWCC>   AsyncEventService -remove

 3. Click Start|Settings|Control Panel, and then double-click the
Add/Remove Programs icon in the Control Panel. The Add/Remove
Program Properties window appears.

 4. Select Command Console V2.2 located in the window, and then click
Add/Remove. The computer asks:

Are you sure you want to completely remove the selected application and all of its
components?

 5. Click Yes. The computer removes only the Command Console Client.

NOTE:  The procedure described only removed the Command Console Client. You can
remove a device-specific Client by using the Add/Remove program (Start|Settings|Control
Panel|Add/Remove Programs).

Creating Your First Virtual Disk
The initial virtual disk on each controller has to be created through a serial
connection. After a virtual disk is created, it can be used as a communications
LUN for a SCSI or network connection. A virtual disk is a group of hard
drives or partitions of hard drives linked together to form a single disk. The
communications LUN establishes a connection between the subsystems and
the command console agent on your host systems. If you remove this
communications LUN, you will no longer be able to use SWCC to monitor the
subsystem.
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Establishing a Serial Connection, Single Controller

The simplest connection to a storage subsystem is a direct, cable connection
from the Client’s host system to one of the storage subsystem's serial ports. To
establish a serial connection, connect a serial cable from one of the computer’s
COM ports to the storage subsystem's CTR TOP (controller in top slot) or
CTR BOTTOM (controller in second slot) configuration port and proceed as
follows:

 1. Open the HSZ22 storage window (Start|Programs|Command
Console|HSZ22 Storage Window). The connection choice dialog box
appears.

 2. Select the Serial option, and then click OK. The HSZ22 Management:
Serial Connection dialog box (Figure 2–3) appears.

 3. From the drop-down menu, select the COM port that connects to your
RA3000 controller, and then click the Connect button. When the
storage window appears, you are connected to your storage subsystem.

Figure 2-3.  Connection dialog box for storage window
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Establishing a Serial Connection, Dual Controller

 1. Perform steps 1 and 2 in the previous section, “ Establishing a Serial
Connection, Single Controller.”

 2. When Client displays the next dialog box (Figure 2– 4), select the
computer’s COM port that the top controller (CTR TOP) is connected
to, then click the Connect button.

Figure 2-4.  Establishing a connection to the top controller



Installing and Setting Up the Command Console Client  2-9

Compaq Confidential –  Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide  Comments: 

Part Number: AA-RBF2C-TE  File Name: c-ch2 Installing and Setting Up the Command Client.doc  Last Saved On: 12/5/00 10:31 AM

 3. On the next dialog box (Figure 2– 5), select the COM port that the
second (redundant) controller (CTR BOTTOM, the redundant
controller) is connected to, and then click the Connect button. Client
displays the dual-controller Storage Window.

Figure 2-5.  Establishing a connection to the second (redundant) controller
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Creating a Virtual Disk by Using a Serial
Connection

Command Console Client can create a number of different RAID levels on
your RA3000. You can create:

■ Single-device virtual disks Just a Bunch of Drives (JBODs)

■ Striped virtual disks (RAID 0)

■ Mirrored virtual disks (RAID 1)

■ Striped mirrored virtual disks (RAID 0+1)s

■ Striped parity virtual disks with fixed parity disk (RAID 4)

■ Striped parity virtual disks with floating parity disk (RAID 5)

Virtual disks are created using command console client’s Add Virtual Disk
Wizard.

NOTE:  If you want to utilize both controllers in the subsystem, they must be configured
for active/active mode. See “ Configuring a Dual-Controller System”
in Chapter 3 “ Using Command Console” .

Starting the Wizard:

Access the subsystem’s storage window. Select Add Virtual Disk from the
Storage menu to start the Virtual Disk Wizard.

To start the Virtual Disk
Wizard, Access the subsystem’s
Storage Window, and select
Add Virtual Disk from the
Storage menu.
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 1. Select the Redundant Array of Independent Disks (RAID) level, and
then click Next. This selection will determine the type of virtual disk
that you will create. In this example, we will create a RAID 5 virtual
disk and partition it into two RAID 5 virtual disks of approximately
equal capacity.

Figure 2-6.  Virtual disk wizard step 1



2-12  Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide

Compaq Confidential –  Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide  Comments: 

Part Number: AA-RBF2C-TE  File Name: c-ch2 Installing and Setting Up the Command Client.doc  Last Saved On: 12/5/00 10:31 AM

 2. Select the devices for your virtual disk by clicking them in the Devices
available to create a new virtual disk windowpane. As you click them,
they are listed in the Details of selected devices windowpane. The
wizard provides helpful information at each step (Figure 2-7). The
wizard tells you that you need to select at least three disks to create a
RAID 5 virtual disk. We have selected the three available devices
located on Channel 0.

Figure 2-7.  Virtual disk wizard step 2 (rack mount model)
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 3. Select the capacity of the virtual disk, and then click Next. The wizard
offers you the option of using only a portion of the capacity of the
devices you have selected for your new virtual disk. It displays the total,
available capacity of the devices you have selected in the capacity box.
Enter the size of the virtual disk you want to create in the capacity text
box, then click Add.

In this example we first created a 4000-MB partition, virtual disk 1, shown in
the virtual Disk windowpane. For the second virtual disk, we will create
another disk from the remaining capacity by clicking Add a second time.
When finished, click Next (Figure 2-8).

Figure 2-8.  Virtual disk wizard step 3
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From the three disk members, you have created two disk partitions: Virtual
disk 1 and Virtual disk 2 (Figure 2-9). You can create from one to eight virtual
disks.

Figure 2-9.  Virtual disk partitions

 4. Specify the strip size and host ports (0 or 1) then click Next. RAID array
management software uses strips in mapping virtual disk block
addresses to member block addresses.

Figure 2-10.  Virtual disk wizard step 4
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 5. Select a logical unit number and cache option (Figure 2-11). Command
console automatically assigns a logical unit number (LUN) for each
virtual disk. However, if you want to change the LUN, click the down
arrow and select the new number from the list. If you want to enable
writeback cache, check the Enable box; then click Next.

Figure 2-11.  Virtual disk wizard step 5
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 6. Confirm and create the Virtual Disks 1 and 2. The Final Virtual Disk
Wizard window, step 6 (Figure 2-12), recaps the choices you have made
in steps 1 through 5. If you are satisfied with your choices, click Finish.

Figure 2-12.  Virtual disk wizard step 6

When you see the Successful Completion dialog box (Figure 2-13), click OK.

Figure 2-13.  Successful completion dialog box
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Figure 2– 14 shows what the storage window looks like during the creation of
the virtual disk. You cannot use the virtual disks until they are finished being
constructed.

Figure 2-14.  Storage window during creation of virtual disks U01 and U02

Figure 2-15.  Storage window after creation of virtual disks U01 and U02
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Installing the Agent Software
If you use command console over a TCP/IP network, then you will need to
install the Agent software on the computer that is connected to your RA3000.
The Agent software provides communication over the network between your
client system and the RA3000. Refer to the Getting Started RAID Array 3000
Installation Guide for your operating system and platform.

Adding a System to the Navigation Tree
When you add a system to the Navigation Tree, you are telling the Client
software to monitor that system. Before you add a system to the Navigation
Tree, you need to have the agent software already installed on that system and
the name of your client system on the agent’s list of client system entries.

 1. From the File menu, click Add System.

 2. Enter your host’s name or your host’s IP address in the host name or
TCP/IP address text box (Figure 2– 14), and click Apply. After you click
Apply, client adds an icon for the added system in the Navigation
Window (Figure 2– 15). In the host name or TCP/IP address text box,
you are told the TCP/IP address has been resolved for the name you
entered.



Installing and Setting Up the Command Console Client  2-19

Compaq Confidential –  Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide  Comments: 

Part Number: AA-RBF2C-TE  File Name: c-ch2 Installing and Setting Up the Command Client.doc  Last Saved On: 12/5/00 10:31 AM

Figure 2-16 shows the Adding an agent system to the Navigation Tree
diagram.

Select Add System from the File menu.

 

 Enter the host name and click Apply.

Figure 2-16.  Adding an agent system to the Navigation Tree

CAUTION:  If the Agent is stopped, status changes in the Navigation Tree, in the
storage window, and in the Windows NT event viewer will not be received. To
obtain the latest status after the Agent has been stopped, you will need to
refresh the display for that system in the Navigation Tree (File|Refresh System)
and in the storage window (View|Refresh). Instead of using the refresh option,
you can close and then open the navigation window and storage window. If
others are managing that system, ask them to notify you before they stop the
Agent software.
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Figure 2-17 shows an example of the system added to the Navigation Tree.

Figure 2-17.  System added to the Navigation Tree

Fault Notification by Pager (TCP/IP
Network Connections)

You can set up Command Console so that it notifies you by a page when a
critical event occurs. This function will work with alphanumeric and numeric
pagers. You can configure this function so that it sends pages to numerous
people at different times. For example, if you have several people, who
monitor the network in shifts, you can configure this function so that the
software only pages the person, who is currently working.

For more information on how to set up the pager notification, see “ Setting Up
Pager Notification”  in Chapter 3 “ Using Command Console” . You can also
find information about paging in the online Help. You can access this section
quickly by going to the index entry, monitoring, faults using pagers, in the
online Help.

CAUTION:  To receive pages, the following must occur:

■ The Asynchronous Event Service (AES) must be running.

■ The Agent service must be running.

■ In the Agent’s list of client system entries, you must select the TCP/IP
notification scheme for your client system.
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Chapter 3
Using Command Console

This chapter contains additional information on how to configure and use
Command Console.

This section provides information on how to configure and use the Command
Console’s features. You can also find information by using the online Help.
For information on your agent, refer to the Refer to the Getting Started RAID
Array 3000 Installation Guide for your operating system and platform. This
chapter provides information on the following topics:

■ About the Asynchronous Event Service (AES)
(TCP/IP Network Connections)

■ Start menu options for Command Console

■ Choosing a connection method

■ Using the Navigation window

■ Configuring a single controller

■ Configuring a dual-controller system

■ Adding devices

■ Creating a virtual disk

■ Deleting virtual disks

■ Modifying virtual disks

■ Managing and creating spare devices

■ Clearing failed devices
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■ Using configuration files

■ Monitoring the status of the RA3000

■ Setting up pager notification

CAUTION:  For your client system to receive updates about your subsystems
over a TCP/IP network, the following must occur:

■ The Asynchronous Event Service (AES) must be running.

■ The agent service must be running.

■ Your client system must be on the agent’s list of client system entries.

About the AES
(TCP/IP Network Connections Only)

The AES is a component of the Command Console client. It runs in the
background as a service that provides status updates of the subsystems to its
client system. For a client system to receive updates it must be running AES
and the agent must also be running. When AES receives a new trap (message),
it passes the trap to the Navigation Tree of the client system that has AES
running. The Navigation Tree, in turn, passes the trap to the appropriate
Storage windows. You can identify a new trap that has been passed to the
Navigation Tree because the status of one or more of its icons will change.

AES can also send traps to predefined pager numbers. To activate this
function, you must predefine each pager number in the User Profile section of
the Event Notification menu.

You can change whether AES starts at boot time. You can also stop or start
AES. However, you need AES running to receive pages notifying you of faults
and to provide updates to the Navigation Tree and Storage window. If AES is
stopped, the client software will no longer provide updates to the Navigation
Tree and Storage window. There will also not be any pager fault notification.
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Stopping and Starting AES on Windows NT and
Windows 2000

Stop or start AES as follows:

 1. Open the Services window (Start|Settings|Control Panel|Services).

 2. Click the AsyncEventSvc entry. The Service window appears.

 3. Click Stop or Start, then click Close.

To disable the AES from automatically starting when your system boots,
perform the following:

 1. Open the Services window (Start|Settings|Control Panel|Services).

 2. Double-click AsyncEventSvc. The Service window appears.

 3. Select Manual under Startup Type.
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Start Menu Options for Command
Console

Command Console client (Figure 3-1) provides you with two program choices:
HSZ22 Storage window and StorageWorks Command Console. Choosing
HSZ22 Storage window allows you to connect to only one storage subsystem.
Choosing StorageWorks Command Console displays the Navigation window,
which contains the Navigation Tree and set up pager notification. You can use
the Navigation Tree to monitor storage subsystems over a TCP/IP network.

Figure 3-1.  Path for Command Console

If you select the HSZ22 Storage window, client displays the How do you want
to connect to the HSZ22 controller? Dialog box (Figure 3– 2). This selection
lets you connect to a storage subsystem by using one of the following
connections: serial, SCSI, or TCP/IP network.

Figure 3-2.  Connection choices for connecting to a single storage subsystem
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If you select StorageWorks Command Console, the first window you will see
is the Navigation window (Figure 3– 3). The Navigation window allows you to
monitor many subsystems over the TCP/IP network. You can also use the
Navigation window to open a Storage window.

Figure 3-3.  StorageWorks Command Console Navigation window

Choosing a Connection Method
The HSZ22 client offers three ways to connect to your storage subsystem:
Over the controller’s serial port, the SCSI bus or over a TCP/IP network. The
serial port and SCSI bus connections are local connections and allow you to
connect to only one storage subsystem. You can connect to one or many
storage subsystems by using a TCP/IP network connection.
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Establishing a Serial Connection, Single Controller

The simplest connection to a storage subsystem is a direct cable connection
from the client’s host system to one of the storage subsystem’s serial ports. To
establish a serial connection, connect a serial cable from one of the computer’s
COM ports to the storage subsystem's CTR TOP (controller in top slot) or
CTR BOTTOM (controller in second slot) configuration port and proceed as
follows:

 1. Select HSZ22 Storage window.

 2. When the Connection Choice dialog box displays, select the Serial
option, then click OK to display the HSZ22 Management: Serial
Connection dialog box (Figure 3– 4).

 3. The drop-down menu, select the computer COM port that your RA3000
is connected to, then click the Connect button to display the Storage
window. When the Storage window displays, you are connected to your
storage subsystem.

Figure 3-4.  HSZ22 Management Serial Connection dialog box for
Storage window
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Establishing a Serial Connection, Dual Controller
 1. Open the HSZ22 Storage window (Start|Programs|Command
Console|HSZ22 Storage window).

 2. When client prompts you for the type of connection, select the Serial
option.

 3. When client displays the HSZ22 Management: Serial Connection dialog
box (Figure 3– 5), select the computer’s COM port that the top controller
(CTR TOP) is connected to, and then click the Connect button.

Figure 3-5.  Establishing a serial connection to the top controller
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 1. In the second HSZ22 Management: Serial Connection dialog box, select
the COM port that the second controller (CTR BOTTOM, the redundant
controller) is connected to, then click the Connect button (Figure 3– 6).
Client displays the dual-controller Storage window.

Figure 3-6.  Establishing a serial connection to the

second (redundant) controller
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Establishing a SCSI Connection, Single Controller

If client’s host operating system is Windows NT or Windows 2000, you can
connect to, monitor and manage one storage subsystem over the SCSI bus.

Before you can connect to your storage subsystem over the SCSI bus, at least
one virtual disk must be configured for the controller. To create the first virtual
disk you must use a serial connection to the subsystem. The procedure to
create the first virtual disk is summarized as follows:

■ Establish a serial connection to your RAID using the Establishing a
Serial Connection, Single Controller procedure provided in this User’s
Guide.

■ Create a virtual disk. See “ Creating a Virtual Disk” .

■ Reboot your system.

■ Start the disk administrator, create the partition and assign the drive
letter for the two virtual disks.

To connect over the SCSI bus proceed, as follows:

 1. Open the HSZ22 Storage window (Start|Programs|Command
Console|HSZ22 Storage window).

 2. When the Connection Dialog box displays, select the SCSI option.

 3. When the HSZ Management: Local SCSI Connection dialog box
appears, select a drive, then click OK (Figure 3– 7). Command Console
will shortly connect to the RA3000 and display the Storage window.

Figure 3-7.  HSZ22 Management: Local SCSI connection dialog box
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Establishing a SCSI Connection, Dual Controller

If Client’s host operating system is Windows, you can connect to, monitor and
manage your RA3000 over the SCSI bus.

Before you can connect to your storage subsystem over the SCSI bus, at least
one virtual disk must be configured for each host port. To create the virtual
disks you must use a serial connection to the subsystem. The procedure to
create the virtual disks is summarized as follows:

■ Establish a serial connection to your RAID using the Establishing a
Serial Connection, Dual Controller procedure provided in this User’s
Guide.

■ Create a virtual disk for each host port. See “ Creating a Virtual Disk.”

■ Reboot your system.

■ Start the disk administrator, create the partitions and assign drive letters
for the two virtual disks.

For a dual-controller configuration, to connect over the SCSI bus proceed as
follows:

 1. Open the HSZ22 Storage window (Start|Programs|Command
Console|HSZ22 Storage window).

 2. When the Connection Dialog box appears, select the SCSI option.
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 3. When the HSZ22 Management: Local SCSI Connection dialog box
appears, select a drive, then click OK (Figure 3– 8). (In this example we
have selected drive PhysicalDrive0 for the first controller, Serial
Number 1163.)

Figure 3-8.  HSZ22 Management: Local SCSI connection dialog box, dual
controller

 4. When the second HSZ22 Management: Local SCSI Connection dialog
box appears (Figure 3– 9), select a drive for the redundant controller. (In
this example we have selected drive PhysicalDrive1 for the redundant
controller, Serial Number 1114.). Command Console will shortly
connect to the RA3000 and display the Storage window.

Figure 3-9.  HSZ22 Local SCSI connection dialog box for redundant controller
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NOTE:  If your agent system has only one SCSI port, you can still establish a SCSI
connection with your dual controllers. For more information, refer to the Hardware
User’s Guide for your operating system and platform.

Connecting Over a Network

To communicate with your storage subsystem over a network, two software
applications are required: Command Console client and Command Console
agent. Client is the Graphical User Interface (GUI), which installs and runs a
Windows NT 4.0 SP4 or Windows 2000 system (minimum level). Agent
installs and runs unseen in the background on the storage subsystem’s host
computer, running Windows NT 4.0 SP6a or Windows 2000 SP1 (minimum
levels.)

Client must be installed before agent. Together the two provide the software
link required for communication over a network. The installation of agent is
covered in the Getting Started RAID Array 3000 Installation Guide for your
operating system and platform. Also refer to online help.

The basic steps for connecting and
communicating over a network:
■ Install and configure Agent on the storage subsystem’s host computer.

■ Check that you have at least one virtual disk created on your storage
subsystem. If necessary, create one using a serial connection to the
RA3000.

■ Select either HSZ22 Storage window (for a single storage subsystem)
or, StorageWorks Command Console (for configuring and monitoring
multiple storage subsystems over a network). Choosing StorageWorks
Command Console displays the Navigation window, a graphical tool for
managing RA3000 subsystems over a network.
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Connecting to a RA3000 over the Network

 1. Open the HSZ22 Storage window from the Start menu
(Start|Programs|Command Console|HSZ22 Storage window).

 2. When client displays the How do you want to connect to the HSZ22
controller? dialog box, select the TCP/IP option. Client displays the
HSZ22 Management: TCP/IP Network Connection dialog box
(Figure 3– 10).

Figure 3-10.  HSZ22 Management: TCP/IP Network Connection dialog box

 3. Enter the host IP name (agent.system.xx.compaq.com is used in this
example) or IP address in the text box, then click Detect Subsystems.
Client will search and find the storage subsystem connected to
agent.system.xx.compaq.com and will display it in the Which
Subsystem Do You Want To Manage? windowpane. Select the storage
subsystem, hsz22-1 in this example; then click Connect. After a short
period of time, Client displays the Storage window. (The name of the
storage subsystem, HSZ22-1, is defined during Agent installation).



3-14  Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide

Compaq Confidential –  Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide  Comments: 

Part Number: AA-RBF2C-TE  File Name: d-ch3 Using Command Console.doc  Last Saved On: 12/5/00 10:20 AM

Creating and Managing a Network of RA3000s

If you select StorageWorks Command Console from the Start menu, Client
displays the Navigation window (Figure 3– 11). The Navigation window is a
navigation tool used to manage and monitor many storage subsystems over a
network. See “ Using the Navigation Window”  section in this chapter.

Figure 3-11.  Navigation window without the Navigation Tree
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Using the Navigation Window
The Navigation window contains a menu bar and the Navigation Tree to help
you in managing your storage systems and subsystems. In this window, you
can configure your pager notification and view the properties of your storage
systems and subsystems. Pager notification is discussed in detail in “ Setting
Up Pager Notification”  in this chapter. In this section, we will focus more on
how you will use the Navigation Tree to view your storage.

You can use the Navigation window to view the status of many storage
systems. When you add systems to the Navigation Tree, you are not impacting
the network. You may want to compare adding a system to when mapping to a
network drive in Windows Explorer. Both provide additional access to a
system. In this case, you will not be accessing files on the system. Instead, you
will be viewing the storage of the RA3000 connected to the system.

For example, two systems, agent.system.xx.compaq.com and
another.agent.sys.xx.compaq.com, have been added to the Navigation Tree
(Figure 3-12). The system, agent.system.xx.compaq.com, is connected to a
storage subsystem named HSZ22-1 and another.agent.sys.xx.compaq.com is
connected to subsystem. When these systems were added, the RAID arrays
that were attached to them were also added to the Navigation Tree.

Figure 3-12.  Navigation window with the Navigation Tree
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Adding a System to the Navigation Tree

When you add a system to the Navigation Tree, you are telling the client
software to monitor that system. Before you add a system to the Navigation
Tree, you need to have the agent software already installed on that system and
the name of your client system on the agent’s list of client system entries.

Add a system to the Navigation Tree as follows:

 1. From the File menu, click Add System.

 2. Enter your host’s name or your host’s IP address in the Host Name or
TCP/IP Address: text box (Figure 3– 13) and click Apply.

Select Add System from the File menu.

 

 Enter the host name and click Apply.

Figure 3-13.  Adding an agent system to the Navigation Tree
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 3. Client adds an icon for the added system in the Navigation window
(Figure 3– 14). In the Host Name or TCP/IP Address text box, you are
told the TCP/IP address has been resolved for the name you entered.

Figure 3-14.  System added to the Navigation Tree

 4. Click the Close button.

Deleting a System
 1. In the Navigation window, click the system that you want to delete.

 2. From the Edit menu, click Delete.
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Creating and Using General Folders

Use folders to help organize your storage. Folders can be dragged and dropped
within the Navigation Tree. Folders can only be placed under the Command
Console root or under another general folder in the Navigation Tree. Folders
can be used to group systems and other general folders, but they cannot be
used to group controllers. In this example we have created the general folder
My Servers and have placed two hosts, agent.system.xx.compaq.com and
another.agent.sys.xx.compaq in the folder (Figure 3– 15). To create a new
folder:

 1. From the File menu, choose New Folder.

 2. Name the new folder in the Navigation window by double-clicking its
label and entering a new name.

Figure 3-15.  Adding a general folder

Renaming a Folder
 1. Double-click the folder name in the Navigation Tree.

 2. Enter the new name. Only user-created general folders that you create
can be renamed.
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Viewing the Hierarchy in the Navigation Window
 1. Click on a folder in the Navigation Tree to display its contents.

 2. Click the plus signs (+) to display more folders, systems, and
controllers. To open a folder, double-click it.

Viewing and Modifying a System Folder’s
Properties

 1. Right-click a system icon in the Navigation Tree.

 2. Click Properties from the Shortcut menu to view the system folder
properties.

Figure 3-16.  System properties for an agent system
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Opening a Storage Window
 1. Connect to a storage subsystem.

 2. In the Navigation window, double click a system folder.

 3. Double-click the Storage window icon to open a Storage window.

Configuring a Single Controller
Your controller’s operating parameters are stored in property sheets. Double-
clicking a controller icon in the Storage window or right clicking on the icon
and selecting Properties accesses controller property sheets. To access a
property sheet, click its tab.

Changes to controller settings require a controller restart to place the changes
in effect. The program prompts you for confirmation before it restarts your
controller.

After you change a parameter that causes a controller restart, there is
approximately a 90-second delay while the controller reinitializes. If the
controller does not communicate with client after this delay, power cycle the
RA3000.

 1. Access the controller’s property sheets by double-clicking the
controller’s icon. The controller property sheet will be displayed. The
controller has four property sheets and can be accessed by clicking on a
tab.



Using Command Console  3-21

Compaq Confidential –  Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide  Comments: 

Part Number: AA-RBF2C-TE  File Name: d-ch3 Using Command Console.doc  Last Saved On: 12/5/00 10:20 AM

 5. The RA3000 has four property sheets: General, Host Ports,
Environment, and Cache.

Figure 3-17.  General controller properties tab
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 6. Click the Host Ports tab to display the host port operating parameters
and set the host port operating parameters. The default settings for
Windows NT are shown in Figure 3– 18. For other operating systems,
refer to the Getting Started RAID Array 3000 Installation Guide.

Figure 3-18.  Host ports controller properties tab
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 7. Click the Environment tab (Figure 3– 19) to verify that the system is
operating within normal environmental parameters.

Figure 3-19.  Environment controller properties tab
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 8. Click the Cache tab (Figure 3– 20) to check cache size. Your RA3000
comes with one 16-MB SIMM installed in slot A.

Figure 3-20.  Cache controller properties tab
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Configuring a Dual-Controller System

NOTE:  To configure the system for dual-controller operation, you should have a computer
with two serial ports. If your computer has only one serial port, refer to the Hardware
User’s Guide.

The default settings for Windows are shown in Figure 3– 21. For other
operating systems, refer to the Getting Started RAID Array 3000 Installation
Guide.

In dual-controller operation each controller must be configured for either
Active/Active mode or Active/Passive mode.

■ In the Active/Active mode, the top controller sees one host port as
active, while the bottom controller sees the other host port as active. The
controllers see their non-active host ports as passive.  If one of the
controllers fails, the surviving controller sees both host ports as active.
Therefore, the surviving controller ensures that both host busses remain
operational. The Active/Active mode can be useful for balancing I/O
activity between controllers.

■ In the Active/Passive mode the primary controller sees both host ports
as active. The remaining controller sees both host ports as passive. If the
primary controller fails, the remaining controller takes over and sees
both host ports as active.

The Active/Active mode is the preferred mode. Configure the Active/Active
mode as follows:

 1. In the Storage window double-click on one of the controller icons to
access its property sheets.
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 2. Click the Host Ports tab to display the host port property sheet
(Figure 3– 21).

Figure 3-21.  Host ports default settings for dual-controller Windows

 3. Set host I/O channel 0 for controller 1 to active.

 4. Set host I/O channel 1 for controller 1 to passive.

 2. Set the channel 0 target ID for controller 1.

 3. Set the channel 1 target ID for controller 2.

 4. Set the mode for both controllers to NT.

 5. To apply the changes on the Host Ports property sheet, Command
Console restarts the controllers. Make sure that the host ports are
quiescent, then click OK.

NOTE:  In Active/Active mode, the system is configured to control one SCSI host port on
each controller. To utilize both controllers, each SCSI port must connect to a host bus
adapter. The two adapters can be in one host system or in two different host systems.
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Adding Devices
The controller must identify all physical devices before they can be used as
virtual disks. On startup or restart, the RA3000 will automatically recognize
any new devices you have installed in the pedestal. You can also add devices
online without restarting the controller. To add a device insert the device in the
slot, select Device from the Storage menu; then New to access the Add New
Device dialog box and then click the OK button (Figure 3– 22).

Figure 3-22.  Add new device dialog box

You can also display the Add
New Device confirmation box
by right clicking on the empty
box on the new device.

Creating a Virtual Disk
Command Console client can create a number of different types of RAID
levels. You can create:

■ Single-device virtual disks (JBODs)

■ Striped virtual disks (RAID 0)

■ Mirrored virtual disks (RAID 1)

■ Striped mirrored virtual disks (RAID 0+1)

■ Striped parity virtual disks with fixed parity disk (RAID 4)

■ Striped parity virtual disks with floating parity disk (RAID 5)



3-28  Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide

Compaq Confidential –  Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide  Comments: 

Part Number: AA-RBF2C-TE  File Name: d-ch3 Using Command Console.doc  Last Saved On: 12/5/00 10:20 AM

Virtual disks are created using Command Console client’s Add Virtual Disk
Wizard as follows:

 1. To start the Add Virtual Disk Wizard access the subsystem’s Storage
window, then click Add Virtual Disk from the Storage menu.

 2. Select the Redundant Array of Independent Disks (RAID) levels, then
click Next. This selection will determine the type of virtual disk that you
will create. In this example, we will create a RAID 5 virtual disk and
partition it into two RAID 5 virtual disks of approximately equal
capacity.

Figure 3-23.  Add Virtual Disk: Step 1 of 6
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 3. Select the devices for your virtual disk by clicking on them in the
Devices Available To Create a New Virtual Disk:windowpane
(Figure 3-24). As you click them, they are listed in the Details of
Selected Devices: windowpane. The wizard provides helpful
information at each step. In Figure 3-24, the wizard tells you that you
need to select at least three disks to create a RAID 5 virtual disk. We
have selected the three available devices located on Channel 0.

Figure 3-24.  Add Virtual Disk: Step 2 of 6 (rack mount model)
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 4. Select the capacity of the virtual disk, and then click Next (Figure 3-25).
The wizard offers you the option of using only a portion of the capacity
of the devices you have selected for your new virtual disk. It displays
the total, available capacity of the devices you have selected in the
capacity box. Enter the size of the virtual disk you want to create in the
capacity text box, then click Add.

In this example we first created a 4000-MB partition, virtual disk 1, shown in
the Virtual Disk windowpane. For the second virtual disk, we will create
another disk from the remaining capacity by clicking Add a second time.
When finished, click Next.

Figure 3-25.  Add Virtual Disk: Step 3 of 6
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From the three disk members, you have created two disk partitions: Virtual
disk 1 and Virtual disk 2 (Figure 3-26). You can create from one to eight
virtual disks.

Figure 3-26.  Virtual disk partitions

 5. Specify the strip size and host port (0 or 1), then click Next
(Figure 3-27).

Figure 3-27.  Add Virtual Disk: Step 4 of 6
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 6. Select a LUN and cache option. Command Console automatically
assigns a LUN for each virtual disk (Figure 3-28). However, if you want
to change the LUN, click the down arrow and select the new number
from the list. If you want to enable writeback cache, check the Enable
box, then click Next.

Figure 3-28.  Add Virtual Disk: Step 5 of 6
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 7. Confirm and create the virtual disks 1 and 2. The final virtual disk
wizard window, step 6 (Figure 3-29), recaps the choices you have made
in steps 1 through 5. If you are satisfied with your choices, click Finish.

Figure 3-29.  Add Virtual Disk: Step 6 of 6

When you see the Successful Completion dialog box (Figure 3-30), click OK.

Figure 3-30.  Add Virtual Disk: Successful completion dialog box
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Figure 3– 31 shows what the Storage window looks like during the creation of
the virtual disk. You cannot use the virtual disks until they are finished being
created.

Figure 3-31.  Storage window during creation of virtual disks

Figure 3-32.  Storage window after creation of virtual disks
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Deleting Virtual Disks

CAUTION:  Verify that you are not deleting the communications LUN. If you
delete the communications LUN, you will not be able to communicate with your
subsystems.

■ Although virtual disks do not exist in a physical sense, it is their logical
structure that ties together the physical pieces of your data spread across
their members. Use extreme caution when deleting a virtual disk. You may
be deleting valuable user data.

 1. In Windows NT, use the Disk Administrator to first delete the partition.

 2. Click on the icon of the virtual disk you want to delete.

 3. From the Storage menu, select Virtual Disk, then Delete.

 4. If Client prompts you for your password, enter it.

 5. When client prompts to confirm the change, click the Yes button to
continue. Client deletes your virtual disk from your configuration and
refreshes the Storage window.
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Modifying Virtual Disks
You can modify the characteristics of your virtual disks in two ways: you can
change its operating characteristics or remove members.

CAUTION:  The virtual disks in your storage subsystem are logical containers
that hold your user data. Use extreme caution when modifying the
characteristics of a virtual disk. You may be putting valuable, user data at risk.

Changing Virtual Disk Operating Parameters

You can change the operating parameters of any of your virtual disks by
accessing their property sheets.

 1. Double-click the icon of any virtual disk to access its property sheets.
The first sheet displayed is the General tab (Figure 3– 33). This tab is
informational and lists the characteristics of the virtual disk.

Figure 3-33.  Virtual disk properties General tab
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 2. Click the Settings tab to access the setting property sheet (Figure 3– 34).
You can change the logical unit number (LUN) or enable/disable
writeback cache. Select a new LUN from the Drop-down menu. Click
the checkbox to Enable writeback cache. To apply the LUN change you
must restart the controller. Click the OK button to save the changes and
exit.

Figure 3-34.  Virtual disk properties Settings tab
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Removing Virtual Disk Members (Deleting Devices)

CAUTION:  Use extreme caution when removing a member of a virtual disk. You
may be putting valuable, user data at risk if you delete a member
inappropriately.

To physically remove a device from your subsystem, you must first remove it
from the controller’s list of known devices. Remove a device from the
controller’s list of known devices as follows:

 1. Click the icon of the device you want to delete.

 2. From the Storage menu, select Device, then Remove From Group.

 3. If the client prompts you for your password, enter it.

 4. When client prompts you to confirm the change, click the Yes button to
continue. Client deletes the device from your configuration and
refreshes the Storage window.

Setting Passwords and Security Options
(Network Only)

Password security prevents unauthorized users from changing or removing
storage configurations. In Command Console, any operation that involves
changing controller, virtual disk, or device settings requires a password.

You do not need a password to view Command Console storage
configurations. A password is not required when client is connected locally to
the storage subsystem via a serial port or host SCSI bus connection. The two
security options, selectable from the Storage window’s Options menu are:
View Only and Make changes (Figure 3-35).

Figure 3-35.  Security options menu

View Only Mode

In view only mode, users can view configurations and monitor storage status,
but cannot make changes to controller, virtual disk, or device properties. To
prevent others from making configuration changes, choose View Only from
the Options menu.
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Password Security

Password security prevents unauthorized users from changing or removing
storage configurations. You created a password when you installed a
Command Console agent on a system. The password is encrypted and stored
in the file where the Command Console agent resides. To set or change a
password, use the Agent Configuration utility.

Command Console allows a valid password to make configuration changes for
one hour. If there is no user input for one hour, Command Console resets itself
to view only. Any configuration change resets the timer and keeps the
password active for one hour.

Managing and Creating Spare Devices
Making a spare device part of a virtual disk will protect the integrity of the
RAID setup.  This proves especially true for virtual disks that have RAID
requirements of two or more devices. Should one device fail, the virtual disk
will automatically activate the spare device, as an instant replacement for the
failed one.

How a Spare Works

■ If a device fails in a RAID 1, RAID 0+1, RAID 4, or RAID 5 virtual
disk, the spare automatically replaces the failed device. The controller
reconstructs all virtual disks the failed device was a member of, as long
as the device was not part of a non-redundant virtual disk.

■ Once the controller writes data to a spare, the spare becomes part of the
same device group in which a device failed.

CAUTION:  If a spare is smaller than the disk that failed, it will not be able to
replace that disk. The spare must be as large as the disk that failed.

To create a spare:

 1. Click the device in the Storage window that you want to make as a
spare. The device must be available, and it must have a capacity equal to
or greater than the lowest capacity drive in the group for an automatic
failed drive replacement.

 2. From the Storage menu, click Device, then click Make Spare.



3-40  Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide

Compaq Confidential –  Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide  Comments: 

Part Number: AA-RBF2C-TE  File Name: d-ch3 Using Command Console.doc  Last Saved On: 12/5/00 10:20 AM

Clearing Failed Devices
You can easily identify a failed device in the Storage window, its icon will
appear with a red X covering it. To clear the failed device from the Storage
menu, select Device, then Clear Failure.

Using Configuration Files
You can use a configuration file to save a particular subsystem configuration
and to view or reconstruct it at a later time. You can revert to one of these
saved configurations at any time. Client reads the configuration file you
choose and sets up your subsystem accordingly. In order to save or restore a
configuration, you must have a serial connection to both controllers.

Saving Configuration Settings to a File
 1. From the Storage menu select Controller, Configuration, then Save
(Figure 3– 36).

Figure 3-36.  Configuration file submenu

 2. When the Save Configuration dialog box displays (Figure 3– 37), specify
a file name in the text box, then click the Save button. The current
configuration settings, including caches, LUNS, host port, and strip size
will be saved to a file at the location you specify.

Figure 3-37.  Save Configuration dialog box
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Restoring Configuration Settings from a File

You can automatically restore/configure your entire storage subsystem from a
previously saved configuration file. Client can configure your subsystem from
a file only if the file corresponds to your subsystem’s hardware configuration.
Make sure that the file you select corresponds to your subsystem’s hardware
configuration.

CAUTION:  Make sure you are completely aware of the configuration information
contained in the configuration file you choose. If you choose a file that is not
compatible with the current configuration of the data on your devices, you put
your data at risk.

 1. From the Storage menu select Controller, Configuration, and Restore.

 2. When the Restore Configuration dialog box displays (Figure 3– 38),
specify the location (path) and file name in the text box, then click the
Restore button. The configuration settings as defined in the file,
including caches, LUNS, host port and stripe size will be restored.

Figure 3-38.  Restore Configuration dialog box

CAUTION:  You will be unable to restore the original configuration settings if the
original hardware and connections have been replaced, or if the original
configuration settings were not saved before implementing the new changes.

Printing a Configuration File

To print a configuration file, select Controller from the Storage menu, then
Configuration and Print.
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Monitoring the Status of the RA3000
Command Console provides two ways to monitor your storage subsystem
visually on the computer’s screen or remotely using pagers.

Icons in the Navigation and Storage windows show the status of host systems,
storage subsystems, devices, and controllers. In addition, an Environmental
Monitoring Unit (EMU) indicator in the lower right corner summarizes the
condition of the power supply, Uninterruptable Power Supply (UPS), fan,
temperature, and expansion cabinets.

If you are connected locally to your RA3000, you must manually refresh the
screen to check system status. Refresh the screen from the Storage window’s
View menu by selecting Refresh.

Pager Notification Provides Updates of Status

You can configure Command Console so that it notifies you by a page when a
critical event occurs on one of your subsystems. This function works with
alphanumeric and numeric pagers. You can configure this function so that it
notifies certain people at different times. For more information on how to set
up pager notification see “ Setting up Pager Notification”  in this chapter.

Navigation Window Icons Show System Status

The icons in the Navigation window change to show system status. For
example, if a device fails in a storage system connected to a controller on a
system, the system folder will indicate the failure. A yellow exclamation mark
indicates a warning condition and a red X indicates failure.

Storage Window Icons Show Device, Controller,
and Virtual Disk Status

The Storage window provides detailed information in both physical and
logical views of an individual storage subsystem in the Storage window. In
each view, icons represent device and virtual disk states. These icons change
to indicate status. A red X through a device indicates device failure.
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In addition an EMU icon in the lower, right corner of the Storage window
indicates a subsystem’s environmental condition. The EMU icon displays a
yellow triangle with an exclamation mark when there is an environmental
problem, such as a fan failure.

Double-clicking on the EMU Icon displays the controller’s Environment
property sheet (Figure 3– 39), which shows main cabinet and UPS status. In
this example, the triangle next to A/C power is abnormal indicates a UPS
failure.

Figure 3-39.  Environment tab
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Setting Up Pager Notification
Command Console will monitor events on your storage subsystem and notify
you of critical events by pager. You can use either an alphanumeric or numeric
pager. If you use an alphanumeric pager text messages will be sent to you. The
message will include the host system name, storage subsystem name, and a
text event message. For numeric pagers you must assign numbers to your host
systems and storage subsystems. The event message will also be a four-
number code, indicating a critical event.

Command Console can send messages that notify either you or a group of
people you designate at different shift times.

The steps for setting up critical event notification by pager are:

■ Set pager preferences. This includes setting your modem’s COM port,
pager service baud rate, and polling interval.

■ Define a user profile. This includes entering your pager number,
identification number (alphanumeric pagers only), and the time period
in which you want to be notified.

■ For numeric pagers only, assign pager codes. This includes assigning
three-digit numbers to the host systems and storage subsystems you
want to monitor.

■ As an option, create a group of people to notify from the user profiles
you have defined.

CAUTION:  To receive pages, the following must occur:

■ The Asynchronous Event Service (AES) must be running.

■ The agent service must be running.

■ In the agent’s list of client system entries, you must select the TCP/IP
notification scheme for your client system.
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Setting Pager Preferences
 1. From the Options menu, click Preferences. The event Notification
Preferences dialog box (Figure 3-40) appears.

Figure 3-40.  Event Notification Preferences dialog box

 2. Enter the polling interval in the Subsystem Polling Interval box. The
standard, default polling interval is 30 minutes.

 3. Select the COM port that your modem uses on your computer.

 4. For alphanumeric pagers select the baud rate, usually 1200, of your
paging service provider’s TAP modem.



3-46  Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide

Compaq Confidential –  Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models) User’s Guide  Comments: 

Part Number: AA-RBF2C-TE  File Name: d-ch3 Using Command Console.doc  Last Saved On: 12/5/00 10:20 AM

Defining a User Profile
 1. From the Options menu, click Event Notification, then User Profiles.

 2. Click the New button and enter a name on the General tab. A
description is optional. Use Edit to make changes to an existing profile.

 3. Select the Pager tab.

 4. Click the Enabled checkbox (Figure 3– 41).

Figure 3-41.  Pager tab configured for a numeric pager

 5. If you have a numeric pager, enter its phone number in the Pager
number: box.

 6. If you have an alphanumeric pager, enter service provider’s TAP phone
number in the Pager number: box. Click the Alphanumeric checkbox
and enter the pager identification number in the Identification Number:
box.

 7. Enter the start and end times in HH:MM, 24-hour format. For example,
08:00 as start and 17:00 as end. Leave both fields set to 00:00 if you
want to be notified 24 hours a day.
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Tips and Notes for Setting Up Pagers

■ If you need to dial a code to access an outside number, it must proceed
the phone number in the pager number field.

■ Do not use commas with alphanumeric pagers, except if required to
access an outside line.

■ If you are configuring an alphanumeric pager, you must supply the
paging service provider’s TAP service modem number in the Pager
Number Text box.

■ When you enter a numeric pager number, you can optionally use one or
more commas to specify a two-second wait interval. Each comma
causes the pager dialer to wait two seconds before sending the pager
identification number to the paging company. You may need to add
additional commas using the trial and error method so that Command
Console will pause long enough for the pager company greetings to
complete.

■ Not every paging company requires a pager identification number. If
your pager is assigned a unique phone number to call the paging
company, do not enter a pager identification number.

■ Command Console supports the TAP paging protocol.

■ See your pager documentation to determine which special characters are
supported.

■ Consult Command Console’s HELP for the latest information on how to
diagnose problems that could arise when sending pages. Help provides
instructions on how to put AES into debug mode.
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Setting Up Pager Codes for Numeric Pagers

Numeric pager support lets you receive notification about critical events by
means of numerical coded messages. A numeric pager usually has three fields
separated by hyphens. The first field signifies the area code, the second field
signifies the exchange, and the third field signifies the four-digit extension.
When you receive a page from Command Console, the first field signifies a
three-digit number for the host system, the second field is a three-digit number
for the subsystem controller, and the last field is a four-digit code for the
critical event.

Figure 3-42.  Numeric pager readout

First, set up pager codes by assigning a three-digit code for each host system.
Next, assign another three-digit code for each subsystem controller connected
to that host. The last four digits are pre-assigned event codes. If you choose,
the event codes can be modified. System codes, subsystem controller codes,
and event codes can only be numeric. Alphanumeric codes are not supported.

Assigning a Pager Code to a Host System
 1. Click a host system in the Navigation window.

 2. From the File menu, click Properties.

 3. Click the Event Notification tab.

 4. Enter a three-digit number in the Pager Identification Number text box.
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Assigning a Pager Code to a Subsystem Controller
 1. Click a subsystem controller in the Navigation window.

 2. From the File menu, click Properties.

 3. Click the Event Notification tab.

 4. Enter a three-digit number in the Pager Identification Number text box.

Viewing and Changing a Pager Critical Event
Code

 1. From the Options menu, click Event Notification Pager Codes.

 2. Click the code you want to edit, then select Edit.

 3. Type the new four-digit pager code in the text box. The default codes
are shown in Table 3-1.

Table 3-1
Pager Critical Event Codes

Critical Event Code Description

Disk fault 1000 Physical device failure

Power supply fault 1001

Fan fault 1002

Battery fault 1003

Temperature fault 1004

Controller fault 1005 Controller has detected internal fault.

Communication fault 1006 Agent cannot communicate with
subsystem.

Other Controller fault 1007 One controller is reporting a fault on other
controller.

External fault 1008

LUN fault 1009 Virtual disk failure
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Setting Up Notification Lists
 1. From the Options menu, click Event Notification, then select
Notification List.

 2. Click the New button and the New Event Procedure dialog box
(Figure 3-43) appears. Enter a name for the new notification list in the
Name: text box.

Figure 3-43.  Setting up a notification list

 3. Type a brief description of the list (optional) in the Description text box.

 4. Add members to the list by clicking the checkbox next to each person’s
name. When you are finished click OK.

 5. Next, associate a host system or controller to the list you have just
created.
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Creating a Notification List

 1. Click a host system or a controller subsystem in the Navigation window.

 2. From the File menu, click Properties.

 3. Click the Event Notification tab.

 4. Select a list from the Notification list (Figure 3-44) drop-down list; then
click OK.

Figure 3-44.  Selecting a group for notification

Tips and Notes for Creating Notification Lists

■ Use notification lists to notify groups of people of critical events.

■ You cannot add a user to a list until a user profile has been created for
the user. Be sure you have created the user profiles first before creating
a notification list.

■ You must first create a notification list before you can associate a
system or controller with a notification list.

■ Use the property pages to associate notification lists with systems and
subsystem critical events.
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Chapter 4
Command Console Client’s Windows,

Menus, and Tools

This chapter describes Command Console’s Client windows, menus, and tools.
Command Console is a Windows-style Graphical User Interface (GUI) that
uses standard Windows navigation, command selection, and configuration
features. Folders are used to arrange storage subsystems and a wizard creates
virtual disks. Options and commands are selected using drop-down menus,
tabs, dialog boxes, buttons, and check boxes. Windows can be sized and
moved or minimized. Command Console client has two main windows, the
Navigation Window and the Storage Window (Figure 4-1).

The Navigation Window is a navigation tool for adding host computers and
storage subsystems to the network and for managing of storage subsystems
over a network.
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The Storage Window provides detailed information on your devices,
controllers, and virtual disks. Every storage subsystem has its own Storage
Window. This window lets you configure your controllers and create and
manage virtual disks.

Figure 4-1.  Console Client navigation and storage windows

Menus and Commands

Drop-down Menus

Both the Navigation Window and Storage Window have menu bars and drop-
down menus. Each drop-down menu presents a group of related functions. For
example, file management functions are located in the File menu.

Menu and Command Access Methods

You can use the mouse or the keyboard to access menus and commands. For
keyboard access press Alt+ key for the underlined letter in the menu name,
followed by the underlined letter in the command name.

Shortcut Menus

Instead of using the standard menus to find the command you need, use the
right mouse button to click a system, virtual disk, device, or folder. The menu
that appears shows the most frequently used commands for that item.
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Navigation Window

The Navigation Window provides a list of all the host computers and storage
subsystems to which Client is connected (Figure 4– 2). The Navigation
Window is made up of host system folders, storage subsystem and general
folders. It has a menu bar, toolbar, and a status bar.

You can use the Navigation Window to see all the systems and storage
managed by Command Console. This is especially useful for monitoring
storage by watching the Navigation Window for problems or failures. The host
systems and subsystems are displayed in the naviagation tree.

Command console will monitor your network connection and storage
subsystem and report status by changing the icons in the Navigation Window.

Menu Bar

Host System

Storage Window
Icon

Storage
Subsystem
 Icon

Status Bar

Toolbar

Figure 4-2.  RAID Array 3000 navigation window
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The Navigation Window uses the following icons:

Icon Name Icon Function/Description

System Folder Shows the node of the
host system containing
controllers, virtual
disks, and devices.

General Folder This is a folder that you
create. A general folder
may be used to group
other folders.

Controller Folder Shows the Storage
Window associated
with a controller.

Storage Window Double clicking the
Storage Window icon
in the Navigation
Window launches a
Storage Window. The
Storage Window shows
all the virtual disks and
devices associated with
a storage subsystem.

System Folders

A system folder shows the node containing storage. The following shows the
four states that system folders can have in the Navigation Tree:

Connection to the system has been established but there is a
critical condition.

Connection to the system is working properly.

A system warning, subsystem may not be fully functional or in
rebuild state.

A grayed out folder means no connection to the storage
subsystem.
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General Folders

A general folder is a container for grouping folders or systems. You can create
general folders with the Add Folder command.

All controllers, virtual disks, and devices inside this
folder are operating properly.

A system warning. Subsystem within the folder may not
be fully functional or in rebuild state.

A grayed out folder indicates no connection to the
subsystem.

A controller, virtual disk, or device inside this folder may
have failed.

Controller Folders

A controller folder shows all the storage associated with a controller.

All virtual disks and devices contained in this folder are
working properly.

A virtual disk or device contained in this folder may have
failed.

A grayed out folder indicates no connection to the
controller.

A virtual disk or device contained in this folder has
failed.
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Navigation Window Menu Bar
The menu bar (Figure 4– 3) is at the top of the Navigation Window .It provides
drop-down menu selections for Navigation Window tasks.

Figure 4-3.  Navigation window menu bar

The menu bar contains the following drop-down menus:

■ File menu

■ Edit menu

■ View menu

■ Options menu

■ Window menu

■ Help menu

These menus and their commands are described in the online Help.
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Navigation Window Toolbar
The Navigation Window toolbar (Figure 4– 4) is located directly under the
menu bar and provides buttons to activate some of the frequently used
Command console functions. To display or hide the toolbar, you can toggle the
toolbar option on the View menu.

Figure 4-4.  Toolbar

Navigation Window Toolbar Buttons

Frequently used Navigation Window functions can be accessed by clicking a
button on the Navigation Tree toolbar. The toolbar buttons are the following:

Add System

Add new Folder

View system properties

Cut folder

Paste folder

Delete folder

View Navigation Tree
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Navigation Window Status Bar
The status bar (Figure 4– 5) provides information about the number of systems
currently connected to the Command Console client and the state of those
connections.

The status bar provides colored status indicators to indicate the current state of
system connections. Red indicates a failure and yellow a warning (possible
failure).

Figure 4-5.  Status bar

A grayed out icon indicates the number of
disconnected systems. In this example 0 systems
are disconnected from client.

A full-color icon indicates the number of fully
functional “ good”  systems. In this example 1
system is good and online.

A yellow triangle with an exclamation mark
indicates the number of degraded systems. In this
example 0 systems are degraded.

A red X indicates a failed system. In this example
there are 0 failed systems.
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Storage Window
The Storage Window (Figure 4– 6) provides detailed information on any
storage subsystem that you have added to the Navigation Tree. You can open a
separate Storage Window for each subsystem you have added in the
Navigation Window.

The Storage Window has a menu bar, toolbar, Virtual Disk Window, Device
Window, and status bar.

In this example (Figure 4-6) two Storage Windows are opened: one for the
host system, another.agent.sys.xx.compaq.com, and one for the agent system
agent.system.xx.compaq.com. The Storage Window for
agent.system.xx.compaq.com is active.

Figure 4-6.  Multiple storage windows opened from the navigation window
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Storage Window Menu Bar

The menu bar (Figure 4– 7) provides drop-down menu selections for the
functions you can perform in the Storage Window.

Figure 4-7.  Storage window menu bar

There are five drop-down menus in the menu bar:

■ File menu

■ View menu

■ Storage menu

■ Options menu

■ Help menu

These menus and their commands are described in the online Help.
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Storage Window Toolbar

The toolbar (Figure 4– 8) provides buttons for performing many of the Storage
Window functions. You can alternately display or hide the toolbar by clicking
the toolbar entry in the View menu.

Figure 4-8.  Storage window toolbar

Icon Name Icon Function/Description

Add Virtual Disk button Enables you to add a new virtual
disk to your storage subsystem.

Cabinet button Displays your devices in a pictorial
view of your cabinet.

Grid button Displays your devices as a logical
array of icons.

Large Icons button Displays your virtual disks as large
icons.

Small Icons button Displays your virtual disks as small
icons.

List button Displays your virtual disks as an
array of small icons.

Details button Displays your virtual disks as a
detailed list.
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Virtual Disk Window

The Virtual Disk Window (Figure 4– 9) provides detailed information about
the virtual disks in the storage subsystem.

Figure 4-9.  Virtual disk window

View Options

You have four options for viewing the information in the Virtual Disk
Window. You can select any one of these options by clicking Virtual Disk in
the View menu (Figure 4– 10).

Figure 4-10.  Virtual disk window view options
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Large Icons, Small Icons, and List Views

If you choose the Large Icons, Small Icons, or List options from the Virtual
Disk option in the View menu, the program uses icons to indicate the
underlying structure (that is, the type) of the virtual disks in the virtual disk
window as follows:

Indicates a JBOD (that is, a
single-disk) virtual disk.

Indicates a RAID 0+1virtual
disk.

Indicates a RAID 0 virtual
disk.

Indicates a RAID 4 virtual disk.

Indicates a RAID 1 virtual
disk.

Indicates a RAID 5 virtual disk.

The program also uses icons to indicate the status of the virtual disks in the
virtual disk window as follows:

Indicates that the virtual
disk is completely
operational

Indicates that the controller is
destroying any data on the
virtual disk and is writing its
own file structure

Indicates that the virtual
disk is not operational

Indicates that the virtual disk is
in the process of regenerating
the data on one of its members

Indicates that the virtual
disk is reduced
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Details View

If you choose the Details option in the View menu (Figure 4– 11), the Virtual
Disk Window displays four information fields:

Figure 4-11.  Virtual disk details view

Name: name client has given your virtual disk.

State: current operational state of the virtual disk. There are five possible
states:

■ Good – virtual disk is completely operational.

■ Failed – virtual disk is completely non-functional.

■ Initializing – controller is destroying any data on the virtual disk and is
writing its own file structure.

■ Reduced – virtual disk has one failed member.

■ Reconstructing – virtual disk is in the process of regenerating the data on
one of its members.

Capacity: The maximum amount of data (in bytes), that the virtual disk can
contain.

RAID level: The underlying structure of the virtual disk. There are five
possible levels:

■ Single disk – virtual disk consists of a single disk drive.

■ RAID 0 – virtual disk is a striped disk.

■ RAID 1 – virtual disk is a mirrored disk.

■ RAID 0/1 – virtual disk is a striped mirrored disk.

■ RAID 4 – virtual disk is a striped disk with a fixed parity disk.

■ RAID 5 – virtual disk is a striped disk with a floating parity disk.

NOTE:  You can change the width of an information field by dragging one of its borders.
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Virtual Disk Properties

You can view virtual disk properties by accessing their property sheets. You
can access a virtual disk’s property sheets directly by double-clicking the
virtual disk’s icon in any view. You can also right-click the icon and select
Properties.

Locating Virtual Disk Members

You can locate the members of any virtual disk by clicking on its icon in the
Virtual Disk Window. Its members appear as shaded device icons in the
Device Window.

Device Window

The Device Window (Figure 4– 12) provides detailed information about the
devices that you have configured in your storage subsystem. You can display a
menu of device icons and their meanings by clicking Legends on the View
menu.

Figure 4-12.  Device window (grid view shown)
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Device Properties

You can view device properties by accessing their property sheets
(Figure 4– 13).. To access a device’s property sheets directly, double-click it or
right click a device icon and select Properties. There are three device property
sheets: General, Membership, and Support Information.

The General property sheet provides general device information such as target
ID, capacity, and transfer rate.

Figure 4-13.  Device general property sheet
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The Membership sheet (Figure 4– 14) shows which virtual disk the device is
part of. In this example the device belongs to virtual disk U02 which is
currently operating in a reduced state.

Figure 4-14.  Device membership property sheet
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The Support Information Property sheet (Figure 4– 15) shows the device by
name and manufacturer. Its firmware revision is also provided.

Figure 4-15.  Support information property sheet
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View Options

You have two options: a grid view or a cabinet view for displaying the devices
in your storage subsystem. You can select either of these options in the Device
selection in the View menu.

Grid View

If you choose the Grid view, the Device Window displays your storage
subsystem as an array of icons. Your devices are arranged vertically in the grid
by device bus and horizontally by target on the bus. Icons indicate each
physical device that you have added to your configuration as described below.
A blank slot indicates that no device is installed or that you have not added an
installed device.

Indicates operational disk used in virtual disk

Indicates a disk that has been added to the configuration
and is available for use in a virtual disk

Indicates a disk that is a spare and is available for
automatic replacement of a failed member in a RAID
virtual disk

Indicates disk that is not operational

Indicates disk that is reconstructing

In grid view, the controllers are arranged just below the device array. Icons
indicate the status of your controllers, as follows:

Indicates an operational controller

Indicates a controller that is not operational
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Cabinet View

If you choose the Cabinet view in the Device selection in the View menu, the
program displays a pictorial representation of your cabinet (Figure 4– 16).

Figure 4-16.  Cabinet view of the pedestal model
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Change View

You can change the view of your cabinet by using the Change View function
in the Storage Window so that it can accurately reflect how your RA3000
appears. The following subsystem cabinet views are offered:

■ Single Bus ■ Rack 4 Shelf

■ Split Bus ■ Rack 3 Shelf

■ Rack 3 Shelf ■ Rack 2 Shelf

■ Rack 1 Shelf ■ Dual Pedestal

■ Single Bus

The following subsystem logical views of virtual disks are offered:

■ Two channel small ■ Two channel large

Figure 4-17.  View of rack four shelf with two channels small



4-22 Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models)

Disk and Controller Properties

You can view very detailed attributes of your disks and controllers by
accessing their property sheets. You can access the property sheets directly by
double-clicking the object’s icon in either view. You can also right-click the
icon, then select Properties.

Locating Virtual Disk Members

You can locate the members of any virtual disk by clicking its icon in the
Virtual Disk Window. Its members are shown as shaded device icons in the
Device Window.

EMU Icon

The EMU icon (Figure 4– 18) provides environmental status of the pedestal
and UPS. The EMU icon is located in the lower right corner of the Storage
Window. Double-click the icon to view the Environment properties sheet.

Figure 4-18.  EMU icon
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Chapter 5
Maintenance and Troubleshooting

This chapter provides system backup recommendations, instructions on how to
upgrade your controller’s software, and troubleshooting tips.

Backing up Files
Configuration and data files should be backed up to prevent the loss of data.
These files contain information about your storage subsystems.

Backing up your Configuration File

Keep a back-up copy of your current configuration file to facilitate restoration
if the storage subsystem configuration file becomes corrupted, if you want to
restore a previous configuration setting, or if you need to reconfigure a failed
controller.
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Backing up Data Files

You should consistently back up your data files to ensure their integrity. Make
sure you have a consistent and comprehensive subsystem backup policy in
place while using command console. If you do not maintain consistent
backups of your data, you put it at risk.

Following good subsystem management practice, you should back up the data
on your disk drives to aid in recovery if there is a primary system failure, if the
integrity of a storage device becomes questionable, or if you experience gross
user error.

The client software does not automatically back up your data for you. Use the
appropriate host backup utilities for this purpose.

Updating Controller Firmware
See the release notes for your version of client for information and restrictions
on downloading various versions of controller software. You can upgrade your
firmware using a network or a SCSI connection as follows:

NOTE:  If the operating system is installed on the RA3000, you cannot use SWCC to
download firmware. Refer to the Getting Started RAID Array 3000 Installation Guide for
your operating system and platform.

 1. From the Storage menu, select Controller, then Update Firmware
(Figure 5– 1).

Figure 5-1.  Update firmware command
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 2. Firmware Update dialog box will appear, asking you to specify the
firmware file that you want to load. You can easily identify Firmware
software by its .fdi extension. Enter the FDI FILE name, then click
Start Update. Upon completion of the firmware update, the system will
automatically reboot and update the controller’s firmware.

Figure 5-2.  Firmware Update dialog box

General Troubleshooting Guidelines
Before contacting Compaq Technical Support, review the following
information and the latest command console release notes to determine if you
have a problem that you can easily correct. Also, keep in mind that system
performance characteristic such as scan and initialization times directly relate
to the capacity of you storage subsystem. If you are using client over a
network, response times are related to network speed and load.

Initializing Virtual Disks

The initialization time for a virtual disk is dependent on the number of
members in the virtual disk and the size of the virtual disk. The virtual disk is
not available for I/O during initialization.

Error Displayed but Current Status Good

If you notice that an error is displayed in client but the current subsystem
status is good, an error may have occurred in the past with a subsequent break
in the communications between client and the controller. To clear the error,
you must exit client and restart.
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Troubleshooting Client and Agent
Connections

■ Make sure the system names used for the client and agent match each
other consistently. As a general rule, always use lowercase letters when
entering names.

■ If you have entered the host name in the HOST file, verify that it is
spelled correctly and that it is in lowercase letters. The host name is not
required in this file, but TCP/IP will look here first when resolving host
names. The HOST file is on the client system in the following directory:

■ On Windows NT,  \WINNT\SYSTEM32\DRIVERS\ETC

■ Make sure you have the correct port numbers in the client’s SERVICES
file as follows:

■ On Windows NT, look in the
\WINNT\SYSTEM32\DRIVERS\ETC\SERVICES file.

Be sure the port entries are followed by a carriage return if they are the last
entries in the file as shown below:

spgui 4998/tcp

spagent3 4994/tcp

■ Make sure the command console agent on the host system is using a
correct host name to recognize the client. If the host system is Windows
NT, run the Agent Configuration Utility (H22AgntCfgWiz.exe) or
examine the client.ini file on the host system. On other host systems,
look at the client.ini file.

■ If you are using a Windows NT Client, run NETSTAT at the MS-DOS
prompt to check the TCP/IP active connections.

■ Check the client name that the agent’s host system sees is the same as
the name specified in the agent's client.ini file. Run NETSTAT at the
MS-DOS prompt on the agent, if you are using a Windows NT host
system, and check the TCP/IP active connections.

■ Make sure the Agent’s host system has been configured to recognize the
client by its assigned name rather than by an alias name. If the host
system has been configured to recognize the client by an alias name,
remove the alias name from the system’s hosts file.

NOTE:  Always reboot the client system after making changes to the hosts or services file.

■ Command Console does not support DHCP (Dynamic Host Configuration Protocol)
connections, where Clients are configured for TCP/IP at system startup time.
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Windows NT Event Logging
The HSZ22 Agent gathers traps obtained from the subsystems and puts them
in the Application Log of the Windows NT Event Viewer program
(Start|Programs|Administrative Tools|Event Viewer). It resides on its
computer and on the client systems that it notifies (Event Viewer is on
Windows NT operating systems only).

To view these traps, go into the Application Log (Log|Application) in the
Event Viewer. The events for your subsystems and Agent will be listed under
the sources: AsyncEventSvc and HSZ22 Agent. You can obtain additional
details of an event, by double-clicking its entry.

For your client system to receive traps, the Asynchronous Event Service
(AES) needs to be running on that computer. Start AES as follows:

Windows NT- Go to Start|Settings|Control Panel|Services. Select
AsyncEventSvc (stands for Asynchronous Event Service), and then click
Start.

CAUTION:  To receive traps in the Application Log of the Windows NT Event
Viewer of the client system, the following must occur:

■ AES must be running.

■ The Agent service must be running.

■ In the Agent’s list of client system entries, you must select the TCP/IP
notification scheme for your client system.



Compaq Confidential –  Need to Know Required
Writer: Bob Young  Project: Command Console V2.2 for the RAID Array 3000 (Pedestal and Rack Mount Models)  Comments: 

Part Number: AA-RBF2C-TE  File Name: f-ch5 Maintenance and Troubleshooting.doc  Last Saved On: 12/4/00 12:11 PM


